STUDY OF EFFECT OF SOLID CONTAMINANTS IN GREASE ON PERFORMANCE OF BALL BEARING BY VIBRATION ANALYSIS

Yogesharao Y. More  
Dr.D.Y.Patil School of Engineering  
Lohegaon, Pune, M.S, India

Prof.A.P. Deshmukh  
Dr.D.Y.Patil School of Engineering  
Lohegaon, Pune, M.S, India

ABSTRACT

Rolling element bearings are common in any rotating machinery. They are subjected to failure under continuous running therefore they have received a great deal of attention in the field of condition monitoring. Machinery vibration monitoring programs are effective in reducing overall operating cost of industrial plant. Monitoring vibration levels over time allows the plant engineer to predict the problems before serious damage and avoid the shutdown of plant. When pending problems are discovered early the plant engineer has the opportunity to schedule maintenance and reduce down time in a cost effective manner. Vibration analysis is used as a tool to determine machine condition and find specific location of machinery problems. This expedites repairs and minimizes cost. In rolling element bearings, contamination of lubricant grease by solid particles is one of the several reasons for an early bearing failure. In this respect, this project work deals with the effect of contamination of lubricant by solid particles on the dynamic behavior of rolling bearings. Generally different materials such as Silica, metal-burr, dolomite-powder, and iron-ore, all at three concentration levels and different particle sizes were used to contaminate the lubricant. Here silica is used as a contaminant. Experimental tests have been performed on the ball bearings lubricated with grease, and the trends in the amount of vibration affected by the contamination of the grease were determined. The contaminant concentration as well as the particle size is varied for each test. Vibration signatures were analyzed with respect to root mean square (RMS) values of amplitude in terms of acceleration and also with respect to acceleration values at particular defect frequencies. From the results, some important conclusions are made about the bearing performance. The results show significant variation in the overall RMS acceleration value and also on acceleration value at every particular defect frequency on varying the contaminant material, particle size of the contaminant, contaminant concentration and running parameters like speed.

INTRODUCTION

Rolling element bearings are common components in rotating machinery. Bearings are in a central position in the monitoring of the condition of rotating machinery. Measurement is usually carried out at the points at which a shaft is supported with bearings and hence the vibration generated by the bearing is included in the vibration signal whether the signal is analyzed or not.
The goal in the development of vibration measurement methods for rolling bearings has usually been to develop techniques for detection of bearing faults in their earliest stage.

**METHODOLOGY**

The silica sand material at three concentration levels and three different particle sizes are used to contaminate the lubricant. Experimental tests have been performed on the ball bearings lubricated with grease, and the trends in the amount of vibration affected by the contamination of the grease are determined. The contaminant concentration as well as the particle size is varied. Vibration signatures are analyzed in terms acceleration values at particular defect frequencies and also in terms of overall root mean square (RMS) values. From the results, some fruitful conclusions are made about the bearing performance. The results show significant variation in the RMS acceleration values on varying the contaminant material, concentration and particle size. At high frequencies, failure of a machine may result from excessive forces which break down the lubrication allowing the surface of bearings to fail (due to metal-to-metal contact). These excessive forces are directly proportional to acceleration (Force = mass x acceleration), because of same here for analysis acceleration parameter is selected.

**FUNDAMENTALS OF CONDITION MONITORING OF GREASE CONTAMINATED BEARINGS**

The deep groove ball bearings are used due to their high load carrying capacity and suitability for high running speeds. The load carrying capacity of a ball bearing is related to the size and number of the balls. Bearing is generally considered as the central part of every rotating machine. The failure of same can cause the complete breakdown of machine. Following are the few causes for bearing failure.

![Contamination vs Bearing Life](image)

**Figure 1. Distribution of the reasons for which rolling element bearings did not reach their calculated lifetime.**
GREASE ACTS AT THE ROLLING CONTACT

Where,
- Po=Hertzian pressure,
- 2b=Pressure surface axis according to Hertz,
- 1=Entry side,
- 2=Exit side,
- 3=Deformation of the roller,
- 4=Lubricant film,
- 5=deformation of the raceway,
- 6=Hertzian pressure distribution,
- 7= EHD Pressure distribution

The Guidelines for Selecting the Lubricant as follows,
- When temperature < 100°C, Grease is suitable.
- When product of bore(mm)*speed(rpm) < 2,00,000, Grease is suitable.
  [In this project work 30 mm*1495 rpm=44,850<2,00,000 therefore selecting the Grease as a lubricant.]
- Grease is suitable for low and moderate loads.

VIBRATION SIGNATURE MONITORING OF ROLLING BEARINGS:

Vibration analysis is a very powerful condition monitoring technique which is becoming more popular and common practice in industry. As a general rule, machines don’t breakdown or fail without some form of warning, which is indicated by an increased vibration level. The increasing level in the vibration signature of a machine can provide a variety of information on many components and structures such as gear meshing frequencies, bearings, structural resonances, and even electrical faults. Different components and defects are generated at different frequencies. Using signal processing techniques to analyze the time and frequency spectrums it can be possible to determine the defect and natural frequencies of various structural components.
The amplitude of the vibration signature gives an indication of the severity of the problem, whilst the frequency can indicate the source of the defect. Most vibration analysis instruments today utilize a Fast Fourier Transform (FFT) which is a special case of the generalized Discrete Fourier Transform and converts the vibration signal from its time domain representation to its equivalent frequency domain representation. However, frequency analysis (sometimes called Spectral Analysis or Vibration Signature Analysis) is only one aspect of interpreting the information contained in a vibration signal. Frequency analysis tends to be most useful on machines that employ rolling element bearings and whose main failure modes tend to be the degradation of those bearings, which typically exhibit an increase in characteristic frequencies associated with the bearing geometries and constructions. In contrast, depending on the type of machine, its typical malfunctions, the bearing types employed, rotational speeds, and other factors, the skilled analyst will often need to utilize additional diagnostic tools, such as examining the time domain signal, the phase relationship between vibration components and a timing mark on the machine shaft historical trends of vibration levels, the shape of vibration, and numerous other aspects of the signal along with other information from the process such as load, bearing temperatures, flow rates, valve positions and pressures to provide an accurate diagnosis.

EXPERIMENTAL WORK
To obtain the desired output following experiment is carries out, wherein an experimental setup is selected along with different bearing samples prepared by adding different contaminants.

PREPARATION OF SAMPLE
Sample term indicates the test bearing which will have the contaminant added in the lubricant. The samples are prepared by following steps,

STEP 1) BEARING SELECTION:
In this project work SKF 6206 deep groove ball bearing is used. Geometry of bearing is shown in fig. and geometrical specification are given in table no.1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value in mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outside Diameter (D)</td>
<td>62</td>
</tr>
<tr>
<td>Bore Diameter (D)</td>
<td>30</td>
</tr>
<tr>
<td>Bearing Width (B)</td>
<td>16</td>
</tr>
<tr>
<td>Ball Diameter (BD)</td>
<td>9.6</td>
</tr>
<tr>
<td>Cage Diameter(Dc)</td>
<td>46</td>
</tr>
<tr>
<td>Contact Angle (β)</td>
<td>0°</td>
</tr>
<tr>
<td>Number of Balls (n)</td>
<td>9</td>
</tr>
</tbody>
</table>

Table 1. Specifications of SKF 6206 Ball Bearing
STEP 2) CONTAMINANT SELECTION
Silica contaminant particles are used for deliberately contaminating the lubricant of the bearings. The required contaminants of different size ranges were obtained using standard sieves and alpine air classifier. The different contaminant levels were obtained using Electronic balance. The separation of particles size and contaminant level preparation was carried out for the silica particles for the selected particles size ranges and contaminant levels. Most of the researchers are used, Metal-Burr, Dolomite Iron-Ore etc. The silica sand contaminant has the different physical properties, i.e. hardness, brittleness and malleability.

Silica: This material is taken from foundry industry. According to information collected, many times the particles of these materials are observed in Lubrication-Failed bearings. Hence this material is selected for study.

Quantity Selection:
The above selected materials are sieved in sieves of different sizes, available in Metallurgy lab of the foundry. The three different sizes are selected as, 53µm, 75 µm and 106 µm for each material. The size is specified by considering the size of sieve used for sieving. The sizes are mentioned below. The contaminant retained on 53µm is here considered as 53µm size for convenience, and the same is applied for other two sizes.

Table 2. Sieve sizes used for contaminant material

<table>
<thead>
<tr>
<th>Sr.No.</th>
<th>On Sieve(µm)</th>
<th>Below Sieve(µm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>53</td>
<td>75</td>
</tr>
<tr>
<td>2</td>
<td>75</td>
<td>106</td>
</tr>
<tr>
<td>3</td>
<td>106</td>
<td>153</td>
</tr>
</tbody>
</table>

These sample sizes are added in the grease in different concentration levels as 5%(0.25gm), 15%(0.75gm) and 25%(1.25gm) of the grease weight. The grease weight is selected by considering a standard empirical relation. The relation is given as,

\[ G = \frac{0.005DB}{0.005*62*16} = 4.96 \text{ gm} = 5 \text{ gm(say)} \]

Where G is grease quantity (gm), D is the bearing outside diameter (mm), and bearing width (mm). [12]. By the calculation made above, the quantity estimated is 5gm.

TEST SAMPLE PREPARATION:
The above selected contaminants are added in the grease and the different mixtures are prepared. The same mixture is added in the bearing, for this a new bearing is taken. The grease which is already present in the bearing is removed by washing the bearing by Kerosene or diesel. The prepared grease sample is then added in the bearing. These bearings are given the specific names as S1C1, S1C2, S1C3 etc. Such 9 bearings are prepared by adding the contaminated grease and one bearing is taken as standard bearing. In this way total 10
sample bearings are prepared. For every type of contaminant and for every size and for every concentration a new bearing is taken.

Table 3. Bearing sample numbers with specifications

<table>
<thead>
<tr>
<th>Sr. No.</th>
<th>Contaminant Mtl.</th>
<th>Contaminant Size (µm)</th>
<th>Contaminant Concentration (%)</th>
<th>Bearing Sample name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Healthy</td>
<td>Nil</td>
<td>Nil</td>
<td>Healthy</td>
</tr>
<tr>
<td>2</td>
<td>Healthy</td>
<td>Nil</td>
<td>Nil</td>
<td>Healthy</td>
</tr>
<tr>
<td>3</td>
<td>Healthy</td>
<td>Nil</td>
<td>Nil</td>
<td>Healthy</td>
</tr>
<tr>
<td>4</td>
<td>Healthy</td>
<td>Nil</td>
<td>Nil</td>
<td>Healthy</td>
</tr>
<tr>
<td>5</td>
<td>Silica Sand</td>
<td>53</td>
<td>5</td>
<td>S1C1</td>
</tr>
<tr>
<td>6</td>
<td>Silica Sand</td>
<td>53</td>
<td>15</td>
<td>S1C2</td>
</tr>
<tr>
<td>7</td>
<td>Silica Sand</td>
<td>53</td>
<td>25</td>
<td>S1C3</td>
</tr>
<tr>
<td>8</td>
<td>Silica Sand</td>
<td>75</td>
<td>5</td>
<td>S2C1</td>
</tr>
<tr>
<td>9</td>
<td>Silica Sand</td>
<td>75</td>
<td>15</td>
<td>S2C2</td>
</tr>
<tr>
<td>10</td>
<td>Silica Sand</td>
<td>75</td>
<td>25</td>
<td>S2C3</td>
</tr>
<tr>
<td>11</td>
<td>Silica Sand</td>
<td>106</td>
<td>5</td>
<td>S3C1</td>
</tr>
<tr>
<td>12</td>
<td>Silica Sand</td>
<td>106</td>
<td>15</td>
<td>S3C2</td>
</tr>
<tr>
<td>13</td>
<td>Silica Sand</td>
<td>106</td>
<td>25</td>
<td>S3C3</td>
</tr>
</tbody>
</table>

EXPERIMENTAL SETUP

The experiment is carried out on the setup which is prepared in the workshop of Dr. D. Y. Patil School of Engineering, Lohegaon, Pune. The figure 6 shows the actual setup on which experimental work is carried out. The specifications of the setup are provided below. The setup is designed in order to have the negligible setup vibrations. Here the set-up vibrations term is very important. When the shaft starts running at high speed the all components start vibrating because of small mechanical errors in alignment. The setup vibrations mixup with bearing vibrations and create the inaccuracy occurs in the measurement. The current setup has negligible such structural vibrations. The setup consists of a motor, two bearings, contact type tachometer, SKF FFT Analyzer, single channel accelerometer etc. The whole setup is mounted on a 20 mm thick metal plate with four acrylic pads.
RUNNING PARAMETERS

Every sample bearing prepared is tested under constant running parameters. The two parameters are size and weight percentage. There is constant speed is selected for carrying out the test. The constant speed selected is 1495 RPM. Total nine combinations are obtained by varying size and weight percentage, for carrying out the test on every single sample bearing. The details of experiment for any sample bearing can be given as follows.

In this way total 9 tests are conducted on nine bearing samples and in this way total 9 bearing samples are tested. Hence in the complete experimental work total 10 tests are conducted.

Table 4. Required Frequency Equations

<table>
<thead>
<tr>
<th>Characteristic frequency (Hz)</th>
<th>symbol</th>
<th>Equations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shaft Rotational Frequency</td>
<td>Fs</td>
<td>N/60</td>
</tr>
<tr>
<td>Inner race defect frequency</td>
<td>Fid</td>
<td>(n/2<em>fr[1+(bd/pd)</em>\cos\beta])</td>
</tr>
<tr>
<td>Outer race defect frequency</td>
<td>Fod</td>
<td>(n/2<em>fr[1-(bd/pd)</em>\cos\beta])</td>
</tr>
<tr>
<td>Ball defect frequency</td>
<td>Fbd</td>
<td>(Pd/2bd*Fr[1-(bd/pd)^2+(\cos\beta)^2])</td>
</tr>
</tbody>
</table>
Where,
N: rotational speed of shaft in RPM
n: No. of balls,
Fr: Shaft Rotation Frequency,
bd: Ball Diameter,
β: Contact angle,
pd: Pitch Diameter

ACTUAL TEST AND DATA COLLECTION

Every test followed a sequence of three steps. In the first step, the bearing is running in healthy grease in order to stabilize the grease temperature. In the second step, the test is continued in healthy grease to collect the vibration data at constant speed. In the third step, the contaminated grease is applied to the bearing. A separate bearing is used for each concentration level of the test. Vibration signals with contaminated grease are acquired from the bearing housing at constant speeds. The above procedure is repeated for all concentration levels. Data is recorded and analyzed with respect to peak values and the root mean square (RMS) values, related to specific defect frequencies.

The calculated fault frequencies at constant speeds are given in above table. These values are further used for analysis. The acceleration values are recorded at these frequency values.

<table>
<thead>
<tr>
<th>Sr. No.</th>
<th>(N) RPM</th>
<th>Fs Hz</th>
<th>Fid Hz</th>
<th>Fod Hz</th>
<th>Fbd Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1495</td>
<td>24.92</td>
<td>139.32</td>
<td>89.70</td>
<td>114.16</td>
</tr>
</tbody>
</table>

Figure 4. Silica Sand Contaminants with healthy & Tested Bearings
RESULTS AND DISCUSSION
By running all the sample bearings at constant running condition, the vibration signatures are obtained. All the collected signatures are analyzed for vibration amplitude in terms of acceleration value. It is found that there is no much effect of load variation hence here for discussion only readings obtained for setup load are presented.

ANALYSIS OF SILICA AS CONTAMINANT
As discussed in above chapter, the data is tried to analyze in terms of peak-values and RMS values, related to specific defect frequencies. Following are some examples of vibration signatures obtained from test by using FFT analyzer when silica is used as a contaminant. The figures show the Acceleration Vs. Frequency graphs for the bearing sample no. S1C1 to S3C3 including Healthy bearing when running at a speed of 1495 RPM.

Figure 5. Acceleration-Frequency plot for bearing sample S3C1 running at 1495 RPM

Figure 6. Acceleration-Frequency plot for bearing sample S3C2 running at 1495 RPM
The Fig. no. 5, 6 and 7 are the signatures obtained for same contaminant material but with 106 µm size and the concentration level increased as 5%, 15%, 25% respectively. It shows that, as the concentration level is increased, the acceleration value at all defect frequencies goes on increasing as compare to 53 micron and 75 micron. This is happening because at higher particle size at higher concentration levels the particles may not come in vicinity of rotating element. The last three figures are obtained for same material with 106 µm size and concentration level varied as, 5%, 15%, and 25% respectively. At this particle size as concentration level increased the acceleration value at inner-race defect frequency decreases and at outer-race defect frequency increases. This is happening because of more weight the particles tend to move the outer side of bearing.

The Fig. no. 6 indicates the signatures obtained for healthy bearing with contaminant free grease. It indicates all the frequencies are at minimum level this is happen because there is no medium present in a grease which produce the vibrations in the same bearings.
Figure 9. S3C1 @ 1495 RPM

Figure 10. S3C2 @ 1495 RPM

Figure 11. S3C3 @ 1495 RPM
STATISTICAL APPROACH

Table 6. RMS & Crest Factor Values

<table>
<thead>
<tr>
<th>Condition of Bearing</th>
<th>RMS (m/s²)</th>
<th>Crest factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner race defect</td>
<td>0.38</td>
<td>0.115</td>
</tr>
<tr>
<td>Outer race defect</td>
<td>0.77</td>
<td>0.075</td>
</tr>
<tr>
<td>Ball defect</td>
<td>0.72</td>
<td>0.095</td>
</tr>
</tbody>
</table>

According to statistical analysis defect detect ability[16] of overall power to be the best followed by RMS and Crest factor measurement. At advance stage of material Wear, bearing damage propagates as crest factor decreases with proportional to RMS value increases.

BEARING LIFE EQUATION APPROACH

Rated Life of Healthy Bearing

\[ L_{10} = \frac{(60 \times N \times L_{10h}) \times 10^6}{10^8} \] .................................(1)

\[ L_{10} = 1435.2 \text{ million revolutions} \]

\[ L_{10} = (C/P)^n \] .................................(2)

\[ P = 1728.74 \text{ N} \]

\[ P = XV Fr + YFa \] .................................(3)

\[ P = Fr = 1728.74 \text{ N} \]
According to ISO-281:2007 the modified or adjusted rating life $L_{nm}$ of the bearing can be calculated from,

$$L_{nm}=a_1*a_2*a_3*a_{iso}*L_{10} \ldots \ldots \ldots (4)$$

Where,

$L_{nm}$=modified or adjusted rating life in million revolutions for special material characteristics and operating conditions.  

**Note (1)**: This life is calculated if, in addition to the load and speed other influences are known such as, 

1) Special material characteristics.  
2) Lubrication  
3) A reliability 90%  

$a_1$-Life modification factor for a reliability  
$a_2$-Life adjustment factor for special material characteristics for standard rolling bearings steels. Generally $a_2=1$ for bearings steels.  
$a_3$-Life adjustment factor for special operating conditions in particular for the lubrication. 

**Note (2)**: To calculate $a_3$ first calculate viscosity ratio $K=V/V_1$  
Where $K$= Viscosity ratio  
$V$=Kinematic viscosity of lubricant at operating temperature($40^\circ$C) in mm$^2$/sec.  
$V_1$=Reference viscosity of lubricant at operating temperature($40^\circ$C) in mm$^2$/sec.  

**Note (3)**: the reference viscosity $V_1$ is determined from the mean bearing diameter $d_m$ and the operating speed in $N$.  

**Note (4)**: alternatively the reference viscosity $V_1$ can also be calculated using the following standard formulas,  

$$V_1=45000*N^{-0.83}*d_m^{0.5} \ldots \ldots \ldots (5)$$

for $N<1000$RPM  

$$V_1=4500*N^{-0.5}*d_m^{0.5} \ldots \ldots \ldots \ldots (6)$$

for $N>1000$ RPM  

Now the Grease lubricant density is,0.91 g/cm$^3$ at standard operating temperature($40^\circ$C)  

**Calculation of $V_1$**:  
Therefore by using above equations,reference viscosity $V_1$ in mm$^2$/sec is,(1495 RPM> 1000 RPM)  

$$V_1=4500*N^{-0.5}*d_m^{0.5} \ldots \ldots \ldots \ldots \ldots \ldots \ldots \ldots \ldots \ldots (7)$$

for $N>1000$ RPM,(1495 RPM> 1000 RPM)  

$V_1=4500*(1495)^{-0.5}*(46)^{0.5}$  
$V_1=4500*0.02586*0.1474$  
$V_1=17.15 \text{ mm}^2/\text{sec}$  

**Calculation of $V$**:  
At $40^\circ$C and $N=1495$ RPM  

$V=50 \text{ mm}^2/\text{sec}$
Calculation of K:

\[ K = \frac{V}{V_1} = \frac{50}{17.15} \]

\[ K = 2.94 \text{ i.e contaminants are present in the lubricant is proved} \]

Calculation of \( a_3 \)

\( a_3 \) = life adjustment factor for special operating conditions in particular for the lubrication. at \( K = 2.94 \), \( a_3 = 3 \) million revolutions.

Now we have calculated values are:

\[ a_1 = 1 \text{……………………90% reliability consider} \]
\[ a_2 = 1 \text{……………………standard rolling bearing steel} \]
\[ a_3 = 3 \text{……………………………………..from } K = 2.94 \]
\[ L_{10} = 1435.2 \text{ million revolutions} \]

Calculation of \( a_{iso} \) - Life adjustment factor for contamination of the lubricant.

\[ a_{iso} = \left[ \frac{(e_c * C_u)}{P} \right] * K \] .............................(7)

\( e_c = \) Contamination factor = 0.3
\( C_u = \) fatigue load limit = 514(N)
\( K = \) viscosity ratio = 2.94
\( P = \) equivalent dynamic load = 1728.74N

Therefore,

\[ a_{iso} = \left[ \frac{(0.3 * 514)}{1728.74} \right] * 2.94 = 0.2622 \]

or as \( d_m = 46 \text{mm and } d_m < 100 \text{ mm; } e_c = 0.3 \text{ to } 0.1 \)

Therefore,

\[ a_{iso} = 0.2622 \]

\[ L_{nm} = a_1 * a_2 * a_3 * a_{iso} * L_{10} \] .............................from Eq.(4)
\[ L_{nm} = 1 * 1 * 3 * 0.2622 * 1435.2 \]

Therefore,

\[ L_{nm} = 1128.92 \text{ million revolutions} \]

**BEARING FEM ANALYSIS:**

Generally ball bearing is a circular component with inner race, outer race, balls and cage. The shaft is fitted into the inner bore diameter of the bearing. The parts of the bearings are subjected to different types of loads and stresses. Apart from this the bearing failure happens due to different reasons namely introduction of contaminants in lubricants, misalignment, dirt, corrosion, insufficient lubrication, overloading, misassemble etc. Therefore bearing should be capable to sustain these distortions that are induced due to contaminants and other causes. In present study to analyze the bearing the harmonic analysis has been used because as all the components of ball bearings are rotated at constant 1495 speed. During analyzing the bearing harmonically, the coefficient of friction between the contaminant and outer race or coefficient of friction between balls and contaminant has been increase so that the stress level in the contact
zone has increases and it is concluded that, the contaminants are affected on performance of ball bearing by simply seeing the stress color contour.

PROBLEM DEFINITION FOR HARMONIC ANALYSIS:

The harmonic analysis of bearing by FEM ensures the following parameters satisfactory,
1) To ensure that bearing withstand the harmonic stresses induced due to solid contaminants and bearing rotation. The harmonic stresses are those stresses which arise due to rotating motion of the machine member.
2) To determine the effect of solid contaminants effect on outer race, inner race and balls of ball bearing.

DATA FOR BEARING GEOMETRY DEFINITION:

The bearing is a complicated structure. The parameters required for FEM analysis are only presented instead of giving all geometrical data. Few of the important specifications of selected bearings are as follows,

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bearing outside diameter, (D)</td>
<td>62 mm</td>
</tr>
<tr>
<td>Bearing bore diameter, (d)</td>
<td>30 mm</td>
</tr>
<tr>
<td>Bearing width, (B)</td>
<td>16 mm</td>
</tr>
<tr>
<td>Ball diameter, (BD)</td>
<td>9.6 mm</td>
</tr>
<tr>
<td>Cage diameter (Dc)</td>
<td>46 mm</td>
</tr>
<tr>
<td>Contact angle, (β)</td>
<td>0</td>
</tr>
<tr>
<td>Number of balls, (n)</td>
<td>9</td>
</tr>
</tbody>
</table>

The material properties which are important for the analysis, are listed as under,

<table>
<thead>
<tr>
<th>Material</th>
<th>Bearing Steel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Young’s Modulus (E)</td>
<td>2.1 x 105 MPa.</td>
</tr>
<tr>
<td>Poisson’s Ratio (μ)</td>
<td>0.3</td>
</tr>
<tr>
<td>Density</td>
<td>8000 kg/m3</td>
</tr>
</tbody>
</table>
GEOMETRY CREATION:

The modeler of ANSYS is somewhat weak as compared to the modeling software’s like Catia, solid works, creo etc. available for the purpose. Creo 2.0 is one of the competent alternatives. The Creo 2.0 is used to model the bearing with all intricate geometric details. The solid model created in Creo 2.0 is shown in fig.5.3

![Solid model of the SKF 6206 Ball Bearing in Creo 2.0](image)

The created solid model was brought into the ANSYS analysis environment using ANSYS – Creo 2.0 interface. Solid model of the typical bearing is complex piece as it has no. of balls, outer race, inner race, and cage. Bearing has many features like outer race, balls, inner race. In ANSYS, solid model is divided into number of small elements. This process is called creating subassemblies

ELEMENT SELECTION AND MESHING:

In simple terms meshing means discretization of entire body into finite number of elemental volumes call elements and interconnected boundaries are called as nodes. An element is the building block of the finite element model. SOLID 95 Element is used for the 3-D modeling of ball bearing. It can tolerate irregular shapes without as much loss of accuracy. Solid95 has compatible displacement shapes and are well suited to model curved boundaries. The element is defined by 20 nodes having three degrees of freedom per node that is translation in nodal X, Y, Z directions. The element may have any spatial orientation. SOLID95 has plasticity, creep, stress stiffening, large deflection, and large strain capabilities.

![Solid 95 Geometry](image)
Meshing is an important step in FEA analysis. The meshing is adequately done to obtain the accurate results while computation. When more the number of elements taken, better accuracy is obtained but simultaneously, the computational time increases tremendously. Total 237983 elements are used in this analysis. In order to obtain accurate information about the stress distribution, more elements are placed at the corners, rounds, and at the contacting points by using ANSYS smart meshing capability. Smart meshing is the special feature in ANSYS meshing capability, which places as much number of elements at points where stress gradient and strain gradient are more. The ultimate purpose is to obtain more accurate information at the very sensitive places.

**BOUNDARY CONDITIONS - HARMONIC ANALYSIS**

Structural loading simply means that fixing outer race and allow rotating inner race and balls. The red color shows in fig. 5.5 is contact region between inner race and balls. The fixed support shown in blue color is provided at outer race and the yellow color shows that the inner race with rotation of shaft.
HARMONIC RESPONSE ANALYSIS

Harmonic analyses are used to determine the steady-state response of a linear structure to loads that vary sinusoidal (harmonically) with time, thus enabling you to verify whether or not your designs will successfully overcome resonance, fatigue, and other harmful effects of forced vibrations.

In a structural system, any sustained cyclic load will produce a sustained cyclic or harmonic response. Harmonic analysis results are used to determine the steady-state response of a linear structure to loads that vary sinusoidal (harmonically) with time, thus enabling you to verify whether or not your designs will successfully overcome resonance, fatigue, and other harmful effects of forced vibrations.

In the selected case study stress and vibration analysis of SKF 6206 ball bearing is discussed. The schematic representation of effect of solid contaminants on outer race is shown in fig. 19 & fig. 20

![Figure 19] Von-Misses stresses on outer race and Balls for healthy bearing

![Figure 20] Von-Misses stresses on outer cage and Balls for contaminated bearing

The FEA analysis outcome is the maximum stresses and amplitude plot induced on outer race and ball bearing to show the effect of solid contaminants. The 3 major kinds of analysis normally performed on bearing includes, statistical analysis, FEM analysis & rated life of bearing analysis.
In the current study, all above 3 types of analysis are performed and their results shows that the solid contaminants affects the performance of ball bearing.

**MODE-SUPERPOSITION HARMONIC ANALYSIS:**

The mode-superposition method sums factored mode shapes (obtained from a modal analysis) to calculate the harmonic response. It is the only method allowed in the ANSYS Professional program. The procedure completes through following five main steps,

i) Building the model.
ii) Obtaining the modal solution.
iii) Obtaining the mode-superposition harmonic solution.
iv) Expanding the mode-superposition solution.
v) Reviewing the results.

**EXPAND THE MODE-SUPERPOSITION SOLUTION:**

The expansion pass starts with the harmonic solution in which calculation has been done of displacement, stress, and force solution. These calculations are done only at frequencies and phase angles that you specify. Therefore, before you begin the expansion pass, you should review the results of the harmonic solution using POST26 and identify the critical frequencies and phase angles. An expansion pass is not always required. For instance, if you are interested mainly in displacements at specific points on the structure, then the displacement solution could satisfy your requirements. However, if you want to determine the stress or force solution, then you must perform an expansion pass.

**MODAL ANALYSIS:**

A modal analysis determines the vibration characteristics (natural frequencies and mode shapes) of a structure or a machine component. It can also serve as a starting point for another, more detailed, dynamic analysis, such as a transient dynamic analysis, a harmonic analysis, or a spectrum analysis. The natural frequencies and mode shapes are important parameters in the design of a structure for dynamic loading conditions. You can also perform a modal analysis on a pre-stressed structure, such as a spinning turbine blade or rotating bearings.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Frequency [Hz]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>96.969</td>
</tr>
<tr>
<td>2</td>
<td>99.014</td>
</tr>
<tr>
<td>3</td>
<td>186.58</td>
</tr>
<tr>
<td>4</td>
<td>186.69</td>
</tr>
<tr>
<td>5</td>
<td>188.99</td>
</tr>
<tr>
<td>6</td>
<td>193.31</td>
</tr>
<tr>
<td>7</td>
<td>193.58</td>
</tr>
<tr>
<td>8</td>
<td>199.49</td>
</tr>
<tr>
<td>9</td>
<td>203.17</td>
</tr>
<tr>
<td>10</td>
<td>207.23</td>
</tr>
</tbody>
</table>

*Figure 22* Rotational Velocity Figure 10. Frequencies at 150 RPM
STEPS INVOLVED IN MODAL ANALYSIS:
To start the analysis, initially the screen details are required to be refreshed. The preliminary housekeeping i.e. where to save the results and analysis files, name of the program etc. are carried out.

CHANGE JOB NAME: FILE > CHANGE JOB NAME > I/P JOB NAME
Change Directory:
File > Change Directory
Import Geometry:
File > Import > Creo 2.0 > model name
The geometry created in Creo 2.0 is imported in ANSYS work bench through ANSYS-Creo2.0 interface through step file format. A solid model is created by taking the exact dimensions as per specifications given by manufacturer catalogue.

![Imported Models From Creo 2.0.](image)

Figure 21 Imported Models From Creo 2.0.

PREPROCESSOR:
Preprocessor > Select Preferences > Structural
The outer cage area surfaces are selected and constrained for all degrees of freedom.

PREPROCESSOR:
Preprocessor > Element type > Add/Edit > Elements
SOLID 95 Element is a higher order 3-D, 20 node element.

MATERIAL PROPERTIES:
Preprocessor > Material model > i/p Young’s modulus, Poisson’s ratio
Application of the fix boundary condition at outer race (all DOF Zero), boundary conditions are applied by considering inner race rotates with balls. The model after boundary conditions may be seen as shown in figure 24.

![Structural boundary conditions of ball bearing](image)

Figure 24 Structural boundary conditions of ball bearing
1) **Meshing:**

Preprocessor > Mesh Tool > Fine Mesh

Solving the solution for reviving the effect: Now ball bearings areas are selected. The corresponding nodes are automatically selected. The coefficient of friction value is applied between selected nodes. The above sub assembly for given coefficient of friction is solved.

2) **Solution:**

Solution > New Solution > Nodal

To see the results and stress contours the final command issued in postprocessor.

3) **Post Processor:**

Post Processor > Solve > Current LS

4) **Post Processor:**

Post Processor > Results

**Results and their Physical Interpretation:**

After applying the boundary conditions, the problem was solved by the ANSYS solver. ANSYS solver formulates the governing structural stress strain equation for each and every element and these formulates governing equations is solved for the deformations from which all the other quantities such stresses, strains etc. can be calculated. The stress pattern for the highest contaminant size and highest concentration level i.e. S3C3 is observed by the use of post processing tool. The various differentiating color contours of the stresses are shown at left side of the figure 25. The figure 25 represents various contours of deformation in three dimensional displacements.

![Figure 25](image1.png)

**Figure 25** Von-Misses Stresses on Outer Race & balls for Healthy Bearings

![Figure 26](image2.png)

**Figure 26** Von-Misses Stresses on Outer Race for Defective (S3C3) Bearings
Graph 1 Convergence for Healthy Bearing

Graph 2 Convergence for Contaminated Bearing (S3C3)

Graph 3 Frequency response for Healthy Bearing in Z-Direction
RESULTS

1) Stress level in the contact zone between balls & contaminants is high in case of contaminated bearing compared with healthy bearing.
2) Rated life of healthy bearing = $L_{10} = 1435.2$ million revolutions.
3) Rated life of contaminated bearing = $L_{nm} = 1128.92$ million revolutions.
4) i.e. due to contaminants introduced in a Grease the rated life of bearings is reduced by 21.34 $\% = 22\%$ (Say)
5) From the overall discussion it is proved that there is a effect of solid contaminants on vibrations and bearing life of ball bearings.

FUTURE SCOPE

It is found that following things can be added as extension to this work,

1. Application of the Finite element analysis method to verify the current results.
2. Other type of bearing can be tested by using the same method.
3. The displacement parameter of vibration can be applied for analysis.
4. The other condition monitoring methods like stator-current method can be applied.

Acknowledgments

I would like to thank Prof. A. P. Deshmukh, Prof. S. K. Rathode, Prof. Amol Patil, Prof. P. A. Makasare Prof. Kashinath Munde, Prof.Ganesh Pokale, Mr. Ankur Kanchan, Dr. S. S. Sonavane for giving me all his support & cooperation for my project work.

Nomenclature

Fs: Shaft rotational frequency
Fid- inner race defect frequency
Fod- outer race defect frequency
Fbd- ball defect frequency
Fcd- cage rotational frequency
V=Kinematic viscosity
\( V_1 = \)Reference viscosity
K= Viscosity ratio
\( a_1 = \)Life modification factor for a reliability
\( a_2 = \)Life adjustment factor for special material characteristics
\( a_3 = \)Life adjustment factor for special operating conditions in particular for the lubrication.
\( L_{10} = \)Rated life of healthy bearing
\( L_{nm} = \)Rated life of contaminated bearing
\( a_{iso} = \)Life adjustment factor for contamination of the lubricant.
\( e_c = \)Contamination factor
\( C_u = \)fatigue load limit
\( P = \)Equivalent dynamic load.

REFERENCES


